
Local Auto Router

EasyEDA suggest that using local auto router rather than using the cloud server, because
when many users using cloud server, the cloud auto router will fail. Only support 64bit system.

For the local auto router, please follow the steps as below:

1.Download the local auto router server.

Download EasyEDA Router：
easyeda-router-windows-x64-v0.8.11.zip
easyeda-router-linux-x64-v0.8.11.zip
easyeda-router-mac-x64-v0.8.11.zip

Supported OS:

2.Unzip it to the User folder, such as driver D.

3.Configure the browser.
Notice:

1)Chrome
The Chrome Browser don't need to be configure, If the local auto router is
unavailable, you have to upgrade Chrome to version 60.0.3112.78 or later.

2)Firefox

1.Type "about:config" into the address bar then press enter.
2.Search and double click the options as below (change the values to "true"):

network.websocket.allowInsecureFromHTTPS

security.mixed_content.block_active_content

- 3.Re-open Firefox.

4.Open the decompress folder, Start local Auto Router(don't need to install, just run
it and keep the command window open):

Double click win64.bat in Windows.

- Windows7(x64) or later 64bit Windows

- Ubuntu17.04(x64) or other 64bit Linux, Linux recommend [Deepin]

(https://www.deepin.org)

- macOS(x64)



Run sh lin64.sh on command terminal in Linux. Open the terminal, use the cd

command to change the directory to the lin64.sh location, and type sh lin64.sh ,

then enter.
Run sh mac64.sh on command prompt in MacOS. Open the terminal, use the cd

command to change the directory to the mac64.sh location, and type sh mac64.sh ,

then enter.
5.Open the editor, open the PCB, Click the Auto Router** icon at editor to start auto-
router.**
If the local router server is available, the dialog will tell you. Click the Run button, the
dialog will show the process.

Tips

Auto router is not good enough, suggest routing manually, recommed "Routing Confilct -
RoundTrack" at the PCB right-hand panel.
Sometimes, if you can't get it done, try the tips below.

Use local auto router rather than cloud server.
Make sure the net of PCB doesn't contain the special charaters, such as ` { } ^ ; ~ \ / [ ] =
etc. the chrarter - and _ are supported.
Make sure the board oultine is closed, doesn't has board oultine overlap situation.
Make sure there are no DRC cleance errors (short circuit issue), such as two different
network pads overlapping, or different net pads in the same location within the package.
Make sure no footprint outside the board outline.
Make sure your canvas Gird size is set to 10mil, make sure the components align with the
grid via: top menu - format - align grid.
Place some vias at suitable position, and modify the vias' net as you want.
Make sure PCB rule doesn't have 3 decimal places, EasyEDA auto router only support 2
decimal places.
Skip the GND nets, add copper area to GND net.
Use small tracks and small clearance, but make sure the value is more than 6mil.
Route some key tracks manually before auto routing and ignore them when auto routing.
Add more layers, 4 layers or 6 layers. but that will make more cost.
Change the components layout, make them have more space between each other.
Don't make any via/pad overlap the different objects which can be set the net.
Stop the auto-router, close the script, and re-open the script to run local auto-router
server again.
Sometimes, The auto-router won't work at the first time, please modify the layout and try
serveral times.
If only a few remaining networks cannot be completed, it is a normal phenomenon.
Please manually route the remaining networks.
Tell the error detail to us and send your PCB file as EasyEDA Source file to support@easye
da.com.
https://docs.easyeda.com/en/Export/Export-EasyEDA-Source-File/index.html
via email.

Some professional people don't like the auto router, because they think auto router is not
professional, but you can use the auto router to check your placement to check the density of
your PCB.



At present, the auto router is not good enough, suggest routing manually, we will improve it
in the future.

Copper Area

Copper Area

Sometimes you will want to fill in or flood an area with copper(Copper Pour). Normally after
drawing the copper area, set the net it is to be connected to (floating copper areas are not
recommended because they can cause EMC and Signal Integrity (SI) problems).

Before using Copper Area, please make sure your PCB has a closed board outline!

Usually this copper area will be connected to a net such as GND or a supply rail. You can draw
the outline of a flood using the Copper Area button from the PCB Tools palette.

Copper Area Attributes

When selecting the copper area outline, you can find its attributes from the right hand
Properties panels.



Layer: Bottom, Top, Inner1, Inner2, Inner3, Inner4 etc.;

Net: the net that the copper area is connected to;

Name: set a name for it.

Clearance: clearance of the copper area from other nets and floods;

Pad Connection: direct or spoke (i.e. a cross shaped heat shunt);

Spoke Width: When Pad Connection is Spoke, you can set the Spoke width, which is copper
area fill connect with Pads.

Keep Island: Yes/No. This keeps or removes any isolated areas of copper created as part of
the flooding process. It is usually good practice to removes these unless you really need them
to maintain a more even spread of copper (copper balance) on your PCB.

Fill Style: Solid/No Solid/Grid. Selecting No Solid will removes the fill so that you can see the
tracks more clearly; when select Grid, you can set the grid spacing and grid width.

Copper to BoardOutline: Setting the clearance between copper with board outline.

Improve Fabrcation: Yes/No. If you set as No, you will see much sharp copper corners, that is
not good for PCB fabrication.

Rebuild CopperArea: Click the button to Rebuild Copper Area if you make any changes.

Edit Points: You can edit the copper area shape manually, any shap as you want.



Add/Remove Vias: When you add copper areas at two and more layers which are having
same net, you can add multiple vias for the copper fill area, just click the "Add/Remove Via"
button, then set the via parameter. The vias will avoid the objects if the via conflict the DRC.

Tips

Hotkey E to start draw copper area.

Hotkey L to change drawing type(90 degrees or 45 degrees or Arc)

Hotkey Shift+B to build all of the copper areas.

Hotkey Shift+M to hide copper areas fill zone, just show the copper outline.

Hotkey Delete or BackSpace to redo previous steps.

If you after copper pours but no copper fills show up, you need to set it a net same one
of the PCB nets, or keep the island as YES, and the rebuild the copper area via "Rebuild
Copper Area" button or "SHIFT+B".
If you want to hide the copper area and keep routing tracks, you can set the copper zone
invisible at the right-hand panel.

If you want to cutout some copper corners, you can use "Solid Region - No Solid", and
then set different net for it, and rebuild the copper area.



Notice

.

.
If the PCB size is more than 15MB, the copper filled data is stored in the client or
browser(that is because some copper filled data is too large to save at server), and
the copper area outline data is stored in the file. Therefore, when the PCB is opened
for the first time, the copper area filled data will be automatically pouring and saving
at local, and the second time the PCB is opened, the filled data will be automatically
loaded from the local storage. When you need to draw the forbidden copper-laying
area, please use the "No Solid" property of "Fill Type" to cutout the copper area and
rebuild it, do not use the operation of drawing the area with wires or circles and then
removing the wires or circles to create the forbidden copper pour area. If the PCB
size is less than 15MB, the copper filled data will be saved into file, and you can open
the PCB in another PC without rebuild copper area.

FAQ

Why sometimes it takes a long time to copper pour

Check that the PCB has a large number of polygon pads, which generally appear in the
PCB imported Altium Design files, and if so, manually modify them to Round or Rectangle



pads.

Check if there are a large number of wire arcs, generally appear in the imported Altium
Design PCB, Altium Design picture is a large number of track segments combined, need
to be manually removed.
Check that the board outline is complicated, with overlapping board outlines, or a large
number of board outlines, adjust them manually to reduce the number of board outlines.

Why did I not show the copper fill after copper poured

Your copper area net must have the same pad or via same as the current layer, otherwise
it will be considered an island to be removed. Click on the copper wire frame to modify
the net in the property panel on the right. For example, your pad net is VCC , you lay

copper net needs to be set to VCC .

If you don't change the copper area ne, you can click on the copper outline and modify
the property "Keep Island" to Yes in the right property panel.
The copper area logic of the EasyEAD is based on whether there is a connection or not to
decide whether it is an island, and if there is no element connection to the same net, the



copper area will be considered an island.

Check that the editor version is 6.3 above, 6.3 PCB board open in version 6.2 can not
properly copper pour. Please CTRL+F5 refresh editor page upgrade to 6.3, if it is true that
can not upgrade to 6.3, you must remove the copper area and redraw.

Check that the board outline is closed and that endpoints need to be closed between the
tracks, and that there are overlapping segments of the board outline (usually inside the
imported PCB). Once you can hide all layers, only the board outline layer view is
displayed, and each segment is carefully examined.

Check that the copper area property is set to type No Solid and needs to be set to Solid
or Grid.



Whether to make the copper area invisible, on the right side of the canvas, set the copper
zone to Visible.

Still unable to copper pour may be an editor bug, please contact us.

Why the ratline doesn't disappear when two copper area overlap which are the same net

At present, doesn't support this, that will make the ratline generation very slow. Please
route a track manually to connect these copper areas.

Copper Area Manager

EasyEDA support copper area manager now, you can set the copper order and apply, the
forward copper area will be poured first.

Via: Top Menu - Tools - Copper Area Manager



For example：
The GND on the top and VCC on the top, you can see the clearance is different.

Solid Region

EasyEDA has added a new tool Solid Region for PCB design



This is a very useful, quick way to connect Pads. You can draw a Solid Region to include all of
these pads with same net name, then set the region to the same net name as the pads. It is
like Copper Area but easier to use for small areas. To use Solid Region like this, set the Type
attribute (in the right hand Properties panel) to Solid.

When you drawing the solid region, you can use the hotkey L and space to change the route

type(Arc, 90 degrees, 45 degrees, Free Angle), just like the track routing.

When you finish drawing, you can click the solid region and change its attributes at the right-
hand panel.

Layer: Solid Region su pport many layers, you need to enable the layer at the Layer
Manager first.

Net: When change to top or bottom or other inner signal layer, the solid region can be
set a net to connect other objects. Sometimes, you can use solid region to make the
copper instead of "Copper Area".

Type: Solid,Board Cutout,No Solid ,

Solid: It will fill the solid area.
No Solid: It will cutout the area such as copper area. Notice, if you cutout a
copper area, the solid region's net must different than copper area's net. After
setting to this option, you need to rebuild the copper area with SHIFT+B.
Board Cutout: you can use this feature to create a slot hole(Non Plated Through
Hole).

Edit Points: You can edit the solid region's outline points as you want.

Expose Copper: ou can create an aperture in the solder mask by one click. It's very easy
to do.

The outline of the solid region can not be self-intersection, when it happens, please delete the
self-interation point at "Edit Points".

Design Rule Check(DRC)



EasyEDA provides a real time DRC(Design Rule Check) function. This is a big feature of
EasyEDA. It is hard to fix DRC errors after laying out the PCB. Now EasyEDA will let you know
the error in routing. You will find an X flag to mark the error.

Design Rule Setting

Via at: Tools > Design Rule..., or Via: right-click the canvas - Design Rule... to open the
Design Rule setting dialog:

The unit follow the canvas unit.

Rule: The default rule named "Default", you can add the new rule you can rename and set
parameters for it. Each net can be set a rule.

Track Width: Current rule's track width. The PCB track width can not less than this value.

Clearance: The clearance of different objects which have different net. The clearance of the
PCB can not less than this value.

Via Diameter: The via diameter of current rule. The via diameter of the PCB can not less than
this value. Such as the Hole/Multi-layer Pad's diameter.

Via Drill Diameter: The via drill diameter of current rule. The via drill diameter of the PCB can
not less than this value.

Track Length: All track length of current rule. The length of tracks belong to a same net
should not be longer than this value.Including the arc lenghth. When the input box is empty
the length will be unlimited.

Realtime DRC: After enable, when you routing the DRC will checking all the time, when
appear the error the canvas will show the "X" marking.



Check Object to Copper Area: Check the clearance of the objects to copper area. If you
disable this option, you must rebuild the copper area before generating the Gerber with
SHIFT+B.

Check Object to Board Outline: When you enable, you can set a value to check the clearance
of the objects to board outline.

Apply Design Rule while Routing and Placing Via: When you routing and placing a new via,
them will follow the design rule to set them width and size.

Show DRC Boundary while Routing: When routing you will see a oultine around the track. Its
diameter depends on desgin rule.

Set Rule for a Net

1. Click the "new" button to create a rule, or use the default rule
2. Select one or more networks on the right, support holding down the CTRL key for
multiple selection, and also can perform keyword filtering and rule classification filtering

3. Then select the rule you want to set in the "set rules" section below and click the "apply"
button. The network applies the rule.

4. Click the "Settings" button to apply the rule.

Check the DRC Error

Via "Design Manager - DRC Error" or "Top Menu - Design - Check DRC", click the refresh
icon to run the DRC. If your PCB is a big file, and have the copper area that will take some
times to check the DRC, please wait a while.



After checking, you can view all the error at the "DRC Error", click the error the related objects
will be highlighted.

DRC error type

Clearance: Object to Object. If two different net objects too close, and the distance less
than the Design Rule clearance, it will show the Clrearance error.

Track Length: The track Length of the all same net tracks must less than Design Rule track
Length.



Track Width: The track width must must large than Design Rule track width.

Via Diameter: The via diameter must large than Design Rule diameter.



Via Drill Diameter: The via drill diameter must large than Design Rule drill diameter.

Note:

Footprint Attributes

When selecting a Footprint, you can find its attributes at the right hand Properties panel.

Prefix: It is same as the schematic. If you move the prefix too far away from the footprint, it
will be dragged back to the footprint when you open the PCB again, if you don't need the
prefix please set the prefix display as No.



Layer: You can set a footrpint to be on the TopLayer or BottomLayer, it same as board side.
*Note: The footprint mirrors when it swapping layers. it doesn't support to mirror at current
layer.**

X-Location and Y-Location: Moves the origin of the footprint to a precise position.

Rotation: Rotates the footprint about its origin over the range from 0o to any angle in
1o steps (visually of course multiples of 360o will appear identical).

ID: EasyEDA will assign a unique ID for each footprint automatically, you can't modify it.

Lock: when locked the object, you can not move it by mouse, but if you set the X Y at the
right-hand property panel, the object still moves, and the Locked will lock the object layer too.

Change Attributes in Batch on PCB Editor

Sometimes, we need to change some attributes of multiple objects together, such as the track
width, hole size and font size.
Now, you can select them and do some changes.

Taking the track for an example. If you select 3 tracks, now you can change their Width ,

Layer , Net together. The difference property values will combine as <...> , change it

directly will apply to all seleted objects.

Design Manager

Just like Schematic's Design Manager, PCB's Design Manager can be found via:

Left Navigation panel > Design

or just press the CTRL+D hotkey to open the Design Manager dialog.



Design Manager function:

Filter

Filter to find a component or net.

Jump

Click the icon to jump to folder.

Component

Click a component/Net/DRC Error to highlight it.

Net



Click a net to highlight the tracks/vias with the same net.

Click a incomplete net will highlight the ratline and objects.

Check/uncheck the net to show/hide the ratline of the net.

Double click the net to remove all of the tracks and vias with the net name. If you
want to reroute a net, this is the recommended method to use to un-route it first.

DRC



Click the DRC list, will position the DRC mark on the canvas.

Notice:

Design Manager list doesn't support to refresh automatically, you must click the refresh
icon manually.

Import Changes

Import Changes

Sometimes, while working on a project, you need to make changes to the schematic and then
update your board, to incorporate them.

It's easy to do this with EasyEDA.

Go to the PCB Editor, via: Top Meun > Design > Import Changes

If there are some errors at schematic, such as prefix duplicated, no footprint, it will pop up
notice dialog, the more information please refer： Schematic - Convert to PCB



If no errors, you will get a "Confirm Importing changes information" dialog:

If you are happy with your changes, just click the Apply Change button.

If you want to update the PCB tracks net same as the schemtiac, you need to enable "Also
update track's net" option. The editor will update the related track's net depends on the pad's
net.

The changes will then be passed into the PCB layout and you can then adjust the tracking to
suit.

Notice：

Because of the net of the schematic is generated after calculating, when you change
some netlabel, after Import Changes, the PCB track will not be deleted.
When enable the "Also update track's net" option, after Import Changes, the related
tracks vias will update the net from the pads, there will be some nets changed isn't you
want, you need to change them manually, such change prefix, modify the parts
connection, delete or add part at the schematic, you can change the tracks net via: right-
click the track - click Select menu - Connection, and them all connection will be seleted,
you can change them net at the right-hand property panel.
After Import Changes, there are some action can not be undo.

Panelize

via: Top Menu - Tools - Panelize

Panelize by Editor



If no errors, you will get a "Confirm Importing changes information" dialog:

If you are happy with your changes, just click the Apply Change button.

If you want to update the PCB tracks net same as the schemtiac, you need to enable "Also
update track's net" option. The editor will update the related track's net depends on the pad's
net.

The changes will then be passed into the PCB layout and you can then adjust the tracking to
suit.

Notice：

Because of the net of the schematic is generated after calculating, when you change
some netlabel, after Import Changes, the PCB track will not be deleted.
When enable the "Also update track's net" option, after Import Changes, the related
tracks vias will update the net from the pads, there will be some nets changed isn't you
want, you need to change them manually, such change prefix, modify the parts
connection, delete or add part at the schematic, you can change the tracks net via: right-
click the track - click Select menu - Connection, and them all connection will be seleted,
you can change them net at the right-hand property panel.
After Import Changes, there are some action can not be undo.

Panelize

via: Top Menu - Tools - Panelize

Panelize by Editor



At present, EasyEDA only support to panelize PCB itself, in order to decrease the file size, the
panelized file only panelize the board outline.
Normally, all the PCB factory will support this panelized file, if you not sure, you need to
contact your PCB factory support.

via: Top Menu - Tools - Panelize

The Border height can not less then 3mm.

V-cut:
If you choose V-Cut, the editor will add the v-cut indication track on Board Outline layer at the
Gerber.



Stamp Hole:

When you preview the Panelize Gerber at JLCPCB.com, you will get the image like below:



JLCPCB will take care of your design, they know how to do.

Panelize by Manually

Process:

1. Select the whole board, hotkey CTRL+A .

2. Copy the whole board by reference point, hotkey CTRL+SHIFT+C or CTRL+C . You can only

copy and paste the board outline to become the panelize board.
3. Paste the board via hotkey CTRL+SHIFT+V , this hotkey will keep the prefix and hide the

ratline layer.
4. Paste repeatly, after finish, rebuild the copper area with SHIFT+B , recommend draw

copper area at the end.

Notice

If the board contains plane layer, it can not be panelized by manually, it will not generate
the plane zone as you want.

Layout a PCB Without Schematic



For some small PCB projects, maybe you don't need a schematic. EasyEDA allows you to lay
the PCB directly from the PCB Editor.

1. Start a new PCB
2. add footprints directly from the Footprints from Left Navigation Panel Library -
Footprint

3. and then just route track for them.

The PCB created by New PCB menu directly, it will hide the ratline layer defaultly.

For setting pad to pad connections, you can check the above Connect Pad to Pad section.

PCB Preview

2D View

EasyEDA provide a nice Photo View to help you to check the PCB.

Via: Top Menu - View - 2D View.

After converting the PCB to Photo View, you can see the result as in the image below.



3D View

After click 3D view menu, the server will generate the 3D view file, when the editor loading
finish, you will see a pretty cool 3D view.

Change 3D view attributes at the right-hand panel;
Reset the 3D PCB position at the left-bottom corner icon;
Keep left-click and drag the canvas can change the view direction;
Keep right-click and pan can change the 3D PCB position.

3D model view of the component please check "PCB - 3D Model Manager" and "Footprint -
Import 3D Model" chapter.

3D Model Manager

3D Model Manager



EasyEDA supports for importing 3D models, PCB can view cool 3D models when doing 3D
preview. Exporting PCB 3D model files is not supported yet.

Open 3D model manager: - tools - 3D model manager

When you open it, you can bind 3D models for Footprint, and you can import or search for
user-contributed 3D models. Import tutorial please see: Footprint - Import 3D Model



1. Click the footprint in the list of footprints on the left, and the preview of footprints will be
displayed in the central area. Support multiple selection: hold down CTRL + Mouse click
selection; Hold SHIFT + click select.

2. Select the imported 3D models from the list on the right or directly search the 3D model
uploaded by the user, and search by keyword.

3. Select a 3D library from the list of 3D model libraries and display 2D outline of the top
view of the 3D model in the middle preview area.

4. Adjust parameters:
drag the mouse to align the 2D boundary line with the footprint shape; You can also
adjust the way you enter parameters below. The right side of the parameters can be
previewed directly, and it supports a long left - click drag 3D preview interface.
width/height: the width/height of the 2D shape of the 3D model
X and Y: the X and Y coordinates of the 2D shape of the 3D model
z-axis rotation: in the overhead view, the 3D model rotates anticlockwise. The editor
automatically recognizes the width and height of the footprint and automatically sets the
z-axis rotation to 90 degrees.

X-axis rotation: in the side view, the 3D model rotates counterclockwise



Y-axis rotation: when facing the image, the 3D model rotates anticlockwise

5. After the adjustment, click the "update" button to complete the 3D model binding.
6. Click 3D preview from the preview menu at the top to preview the 3D model.

PCB Information

PCB design information can be easily obtained by checking PCB information.

Entry: Top Menu - Fabrication - PCB Information

Nets shows: routed nets/total nets.

PCB Module



EasyEDA support create the PCB modules, it seems schematic module.

How to Create

Via: Save as Module and File > New > Schematic/PCB Module。

PCB module save at Library > Schematic/PCB module > Work Space > My Libraries

How to use

Since v6.4.3, after placing schematic modules and PCB modules, after Import Changes,
supports to keep the layout location.

How to use:

1. Draw schematic modules and PCB modules, and ensure that their component prefix are
one to one, and the footprint is also corresponding. The module's component prefix can
not have question marks and duplicate prefix, such as U? or two R1.

2. Open schematic and PCB at a same project.
3. Open "Library", select the module.
4. Click the "Place" button to place the previous saved schematic module and PCB module.



5. It will pop up a window to enter English letter. The letter of schematic module should
keep corresponding with PCB modules.

For example: A component at schematic module is U2, enter letter K, press OK to place
into canvas, it will be KU2, then PCB module has KU2 too.
Click "OK" and enter the placement mode. After each placement, the pop-up will
continue to enter the identification letter. Make sure that the identification letters entered
each time are unique.

6. When finish the module place, the PCB component unique ID will same as Schematic
component unique ID, then after Import Changes, the component's location will be keep.
and you can update the track's net follow the schematic netlabel too.

That implement the multipe chanel placing.

Notice:

Module composes by tracks and components, it doesn't same as symbol binding
footprint, the schematic module can not binding PCB module, after placing, the module
will be separated by many objects, only the symbol and footprint can be corresponding
via component ID, that is why you need to make the identication letter unique for placing
each time to make sure schematic module corresponding with PCB module.

Generate Fabrication File(Gerber)

Generate Fabrication File Gerber

When you finish your PCB, you can output the Fabrication Files(gerber file) via: File >
Generate PCB Fabrication File(Gerber) , or Fabrication > PCB Fabrication File(Gerber).

After clicking, will open the Gerber generate dialog:



You can calculate the price for the PCB order, click SAVE to CART will go to JLCPCB and add
your PCB in the cart.

Gerber file name

The generated Gerber file is a compressed zip file. After decompression, you can see the
following files:

Gerber_BoardOutlineLayer.GKO: PCB Border file. The PCB board factory cuts the shape
of the board according to this document. The groove drawn by the EasyEDA, the solid
region(Type: NPTH) is reflected in the border file after the Gerber is generated.
Gerber_TopLayer.GTL: Top side copper layer.
Gerber_BottomLayer.GBL: Bottom side copper layer.
Gerber_Inner1.G1: Inner copper layer, signal type.
Gerber_Inner2.GP2: Inner copper layer, plane type
Gerber_TopSilkLayer.GTO: Top silkscreen.
Gerber_BottomSilkLayer.GBO: Bottom silkscreen.
Gerber_TopSolderMaskLayer.GTS: Top solder mask. The default board is covered with
green oil, and the elements drawn on this layer correspond to the top layer's area will not
be covered with oil.
Gerber_BottomSolderMaskLayer.GBS: Bottom solder mask. The default board is
covered with green oil, and the elements drawn on this layer correspond to the bottom
layer's area will not be covered with oil.
Drill_PTH_Through.DRL: Plated drill through hole layer. This document shows the
location of the hole where the inner wall needs to be metallized. Old name:
Gerber_Drill_PTH.DRL
Drill_NPTH_Through.DRL: Non-Plated drill through hole layer. This document shows the
location of the hole where the inner wall don't need to be metallized. Old name:
Gerber_Drill_NPTH.DRL
Gerber_TopPasteMaskLayer.GTP: Top Paste Mask, for the stencil.
Gerber_BottomPasteMaskLayer.GBP: Bottom Paste Mask, for the stencil.
Gerber_TopAssemblyLayer.GTA:Top Assembly, read only, doesn't affect the PCB
manufacture. Old name: ReadOnly.TopAssembly



Gerber_BottomAssemblyLayer.GBA: Bottom Assembly, read only, doesn't affect the PCB
manufacture. Old name: ReadOnly.BottomAssembly
Gerber_MechanicalLayer.GML: Record the information on the mechanical layer in the
PCB design, and only use it for information recording. Old name: ReadOnly.Mechanical.
By default, the shape of the layer is not manufactured at the time of production. Some
board manufacturers use the mechanical layer to make the frame when using Altium file
to production. When using Gerber file, it is only used for text identification in JLCPCB. For
example: process parameters; V cut path etc. In EasyEDA, this layer does not affect the
shape of the border of the board. If the mechanical layer has closed wires, JLCPCB will
give priority to using the mechanical layer as the shape of the board when producing the
board. If there is no outer frame of the mechanical layer, GKO will be used as the frame
(historical influence of Altium file). It is necessary to pay attention to the use of the
mechanical layer in the design.

Notice:

Gerber View

Before sending Gerber to the factory, please use gerber viewer to check the Gerber carefully.

local gerber viewer you can use such as: Gerbv, FlatCAM, CAM350, ViewMate, GerberLogix etc.

Gerber viewer recommend Gerbv:

Project page:http://gerbv.geda-project.org/
Download: https://sourceforge.net/projects/gerbv/files/

How to use Gerbv:

1.Download Gerber zip file, and download Gerbv, unzip Gerber file and run the Gerbv;



2.Click the + button at the Gerbv dialog bottom-left corner, open the gerber folder, select all

the gerber files, and open.

3.And then zoom, measure, check every layer, check drill holes and location. etc.

FlatCAM is a nice tool too: http://flatcam.org/

FlatCAM lets you take your designs to a CNC router. You can open Gerber, Excellon or G-code,
edit it or create from scatch, and output G-Code. Isolation routing is one of many tasks that
FlatCAM is perfect for. It's is open source, written in Python and runs smoothly on most
platforms.

Free Online Gerber Viewer:

Recommend：
jlcpcb.com
tracespace.io/view
gerber.ucamco.com

Export BOM

You can export the Bill of Materials (BOM) for the schematic (Document) and PCB, via: "Top
Menu - File - Export BOM", or "Top Menu - Fabriaction - BOM".

After clicking the BOM export option, the dialog below will open.


